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IBM WEBSPHERE 6.0.2 — LAB EXERCISE

Introduction to Service Component Architecture

What thiS @XErCiSE IS @DOUL ........vei i e e e e e n e e e nnr e nneas 1
(Lo I €T D11 T 41T | CS PP STRT 1
LTATA g LYo TU IR g T U] o N oY== ] =N 1o o o SR 1
1o o (U1t i o] o E T PP PPPRPPPPPPPPN 2
EXEICISE INSIIUCTIONS ....eiitiee ittt ettt ettt e e e s s et e e st e e R et e b e e s et e s E et e nen e e ns e e e n e e e ne e e e nnne e e 3
Part 1: Set up the development ENVIFONIMENT ..........oii i e e e e e e e e e e e e e e s e e ennbeeeeaaeeesanreeeees 5
Part 2: Build the HellOWOrI MOTUIE .........couiiiie ettt ettt e et e e e b e e e sbreee e e 6
Part 3: Testing HelloWorld from the Web iNterface ............ovvvieiiiiiiiie e e 16
Part 4: Testing using the Integration teSt CHENT...........o e 18
Part 5: ReStore SErver CONFIQUIALION ..........ciiii it e e s st s s r e e e e e st e e e e e e s s s sebaeeeeaeessaanteaeeaaeeesnnnnreees 20
What You did iN thiS EXEICISE ... ... ettt e e e ettt e e e e e e e s anbe e et e e e e e s e nbnbeeeeaaeeeaannnnreees 21
o] 11T T £ £ ot o T PP TP U PP SRR 22
Task: Adding remote server to WebSphere Integration Developer test environment ..........cccccveeveeeeevcciineeenenn. 23

What this exercise is about
The objective of this lab is to provide you with an understanding of how to use the WebSphere® Integration
Developer V6.0.2 tools to build an application that is based upon the service component architecture
(SCA).

Lab requirements
List of system and software required for the student to complete the lab.
* WebSphere Integration Developer V6.0.2 installed

* WebSphere Process Server V6 test environment installed

«  Sample code in the directory C:\Labfiles602 (Windows®) or /tmp/LabFiles602 (Linux® and AIX®)
What you should be able to do

At the end of this lab you should be able to:

» Create a new business integration module

» Use the interface editor to define a simple WSDL interface
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* Use the assembly diagram editor to:

o Define a simple service component with a single WSDL port type interface and a Java"
implementation

o Define a stand-alone reference to the simple service component

0 Assemble a service module
» Use the SCA client programming model to invoke a service component from within a service client
» Test the service component invocation from a

o Client JSP

o Test framework

Introduction

The Service Component Architecture (SCA) is a service oriented component model for building business
services that publish or operate on business data, and is the foundation upon which applications running
on WebSphere Process Server V6 are built. In this exercise you will build a simple “Hello World”
application that will provide an introduction to SCA and the authoring tools provided with WebSphere
Integration Developer V6.0.2.

The Hello World application in this exercise consists of a single service component that is associated with
a simple WSDL interface definition that includes a sendMessage operation. The service component in this
application uses a Java implementation (POJO — Plain Old Java Object) to provide the sendMessage
functionality. Once the simple service component is built you will define a stand-alone reference that will
enable the HelloWorld service to be invoked by a service client (such as a JSP) using the SCA client
programming model. The following is a diagram illustrating the SCA module you will build in this exercise:

-

Standalone Reference
index.jsp R— I
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.
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Implementation
Java
HelloWorldinterface.wsdl
HelloWorldimpl.java .~
Figure 1
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Exercise instructions

Some instructions in this lab may be Windows operating-system specific. If you plan on running the lab on
an operating-system other than Windows, you will need to run the appropriate commands, and use
appropriate files ( .sh vs. .bat) for your operating system. The directory locations are specified in the lab
instructions using symbolic references, as follows:

<LAB_NAME> Helloworld Helloworld

<WID_HOME> C:\Program Files\IBM\WebSphere\ID\6.0 | /opt/IBM/WebSphere/ID/6.0

<WPS_HOME> <WID_HOME>\runtimes\bi_v6 <WID_HOME>/runtimes/bi_v6

<LAB_FILES> C:\Labfiles602 /tmp/Labfiles602

<TEMP> C:\temp /tmp

<SOLUTION> C:\Labfiles602\SCA\HelloWorld\Solution Gt/rgp/lLe}bfile5602/SCA/HelIoWorI
olution

Windows users’ note : When directory locations are passed as parameters to a Java program such as
EJBDeploy or wsadmin, you must replace the backslashes with forward slashes to follow the Java convention.
For example, C:\LabFiles602 would be replaced by C:/LabFiles602

Note that the previous table is relative to where you are running WebSphere Integration Developer. The
following table is related to where you are running remote test environment:

<SERVER_NAME> Serverl clisr0l

<WAS_HOME> C:\Program letc/cllcell/AppServerNodel
Files\IBM\WebSphere\AppServ
er

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<BOOTSTRAP_PORT> 2809 2809

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrv0l default

<USERID> N/A clladmin

<PASSWORD> N/A frlday
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Instructions for using a r emote testing environment, such as z/OS, AIX or Solaris, can be found at
the end of this document, in the section “Task: Adding Remote Server to WebSphere Integration
Developer Test Environment "
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Part 1: Set up the development environment
1. Start WebSphere Integration Developer V6 with a new workspace

___a. Select Start > Programs -> IBM WebSphere -> Integration Developer V6.0.2 - WebSphere
Integration Developer V6.0.2 from the start menu.

___b. Enter <LAB_FILES>\<LAB_NAME>\workspace for your workspace and click OK when
prompted.
Workspace Launcher

Select a workspace

1EM WebSphere Integration Developer stores wour projects in a directory called a workspace.,
Select the workspace directory bo use for this session,

W orkspace: I C:LabFilesa0zHelloWyarldyworkspace j Browse, .. |

™ Use this as the default and do not ask again

; Cancel |
___c. Close the Welcome page after WebSphere Integration Developer V6.0.2 opens.
_ Integration Developer Go to the Business Integration perspective@
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Part 2: Build the HelloWorld module

1. The fundamental project type for building SCA applications in WebSphere Integration Developer
V6.0.2 is called a Module. Begin building the HelloWorld application by creating a new Module
called Helloworld .

___a. Select File - New - Other.
___b. Expand Business Integration and select Module .
Select a wizard

Creates a new business integration module,

Wizards:

[=]-[2= Business Integration LI
----- [} Business Object

----- =) Business Cbjeck Map

----- Business Process

----- = Business State Machine

----- 3 Custom Visual Snippet

----- = Decision Table

----- tiﬁ Ermulator

----- ['frl.;r; Enterprise Data Discovery
----- i}'=¢' Enterprise Service Discovery
-3 =] Human Task,

----- (ﬁ‘ Interface

[ shaw all Wizards, 7

= Bach I Mexk = I Eimist Cancel

___c. Click Next.
___d. Enter HelloWorld for the Module name and click Finish .
2. The SCA component in this application is associated with a WSDL interface called
HelloWorldinterface (See Figure 1 of the Introduction section). Create a new WSDL interface with
this name.

___a. Expand Helloworld from the Business Integration view.

__b. Right click on Interfaces and select New - Interface .
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___c. Enter HelloWorldinterface for the name and verify that the selected Module is HelloWorld .
___d. Click Finish .

3. The HelloWorldinterface has a single operation called sendMessage that takes a string message as
input and returns a status string. Use the WSDL editor to define the sendMessage operation on the
HelloWorldInterface.

___a. After completing step 2 above, the WSDL editor should be open in your workbench.

___b. Click the Add Request Response Operation icon %;?(%;?) at the top of the WSDL editor.

___c¢. Change the operation name from operationl1 to sendMessage .

NOTE: The name of the operation can be modified from either the properties view or within the interface
editor itself.

___d. Click on the Add Input icon (Q]) at the top of the WSDL editor.
___e. Change the inputl input name to message and accept string as the type for the input parameter.

___f. Click on the Add Output icon (450) at the top of the WSDL editor.

___g. Change the outputl output name to status and accept string as the type for the output
parameter.

__h. Verify that your interface matches the following diagram.

NOTE: By default when a new operation is added, an input named inputl and output named output are
created. The above steps d & f hold good when you want to have more than one input and output.

~Dperations ) i |
Ciperations and their parameters
| Mame Tvpe
i sendiiessage |
L1 Inputis) TMEessage skrirng
[E» Cukpukis) stakus skring

___i. Save and Close the WSDL file.

4. The SCA component used in this application uses a Java implementation for the WSDL interface
defined in the previous step. Import the Helloworldimpl.java file for this implementation.

___a. Select File = Import from the menu.
___b. Select File system for the import source and click Next.

___c. Use the Browse button to select <LAB_FILES>\SCA\HelloWorld \import  for the “from”
directory.

___d. Select the checkbox next to HelloWorldimpl.java .
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___e. Specify the ‘Into folder ' as HelloWorld\sample .

4= Import

File zpstem

Import resources from the local file system,

Fram directory: I CriLabFiless0zysC A Heloworldlimport

j Braowse... |

...... [>= import

Filter Tvpes.. | Seleck Al Deselect Al |

. Hella'WarldImpl, java
O & index jsp

Into Folder: I Hello\Warldysample

Optians:
[ ] Owerwrite existing resources without warning
" Create complete folder struckure

¥ Create selected Folders only

< Back

[ext = | Cancel |

___f. Click Finish .

5. The primary tool for composing an SCA-based application is the assembly editor.

Open the

assembly editor for the HelloWorld module and build the SCA module illustrated in Figure 1 of the
Introduction section.

___a. Go to the Business Integration view, expand HelloWorld and double click on Assembly Diagram
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SMERERE ) t0 open the assembly editor for the HelloWorld module...

&

[ Business Integration xR

COE v

Dependencies
& Business Logic
. 2 Data Types
@ Interfaces
---o&. Mapping

“oo ¥ Events

Assembly Diagra
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___b. The assembly editor will open in your workspace.

NOTE: The assembly editor consists of a canvas area and a palette for selecting components to add to
the diagram. The palette is located to the left of the canvas area. To locate some of the nested items that
can be added to a diagram, click the gray > symbol next to the parent item on the palette.

-

-
?éﬁ Sssembly Diagram: Helloworld &3 B

(1) add a new artifact from the palette on the le. .. artifact from the Business Integration wview, &4

|‘-i- I

SO »]

___ €. Add a service component to the canvas of the assembly diagram.

: . . I .
__d. NOTE: To do this, locate and click the component icon (') from the palette and then click
anywhere on the canvas area of the assembly diagram. In the assembly diagram, select the
component added in the previous step.

___e. Use the properties view to change the Display name and Name of the component from
Componentl to HelloWorld . This property can be found on the General tab.

___f.In the assembly diagram select the HelloWorld component and select the Add Interface icon
S
(‘3') from the hover over menu.

NOTE: The hover over menu will pop up if you position your mouse over a component selected in the
diagram.

___g. Select the HelloWorldinterface from the ‘Matching interface ° list and click OK.

__h.In the assembly diagram right click on the HelloWorld component and select Select
Implementation - Java from the context menu.
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___i. When the Select Implementation dialog appears, begin typing HelloWorldimpl into the “Select
entries” box. Select the HelloWorldimpl from the “Matching types” lists when it appears and
click OK.

___j- Return to the assembly diagram and add a stand-alone reference to the diagram. To do this,

locate and click on the stand-alone reference icon () on the palette and then click anywhere
on the canvas of the assembly diagram. The following diagram indicates where to find the
stand-alone reference icon.

Etand-alone References|

g
___k. In the assembly diagram select the stand-alone reference and click the Add Reference icon (I"——'I)
from the hover over menu.

__LIn the Add Reference dialog, enter HelloWorldinterfacePartner for the name. Select the
HelloWorldinterface from the ‘Matching Interface ' list and click OK.

___m. Click Yes when prompted if you would like to convert the WSDL interface to Java interfaces.

= Add Reference |

There are one ar more references on this component that are described by

WSDL inkerfaces. It is simpler to develop Java clients if they use companent
references that are described as Java interfaces, Would waou like to conwert
the WS3DL interfaces used by this component's references so that they use

Java interfaces?

[~ Remember my decision and do not ask me again

o Help

__n. Create a wire between the stand-alone reference and the HelloWorld component. To do this,

i
select the wire tool ( 1-=') on the palette. Then, click on the reference box on the stand-alone
reference (*:!') followed by the Helloworld component.

___ 0. Click on the selection tool ( s ) from the palette.

___p- Verify that your assembly diagram looks like the following.

2007 April, 04 IBM WebSphere 6.0.2 — Lab Exercise Page 10 of 26

WPSWIDv602_SCAlntroLab.doc



© Copyright IBM Corporation 2007. All rights reserved

Stand-alone References 1.1 o @ Hellotworld

NOTE: You can automatically arrange the contents of the assembly diagram by right clicking on the
assembly diagram and selecting Arrange Contents Automatically . You may need to press the Esc key
or click again on the wire tool on the palette to right click in the assembly diagram.

__ Q. (Optional) Click on the wire connecting the stand-alone reference and the HelloWorld
component. Use the properties view to inspect the wire definition. Notice that the reference
name is HelloWorldinterfacePartner. This name will be used in the client JSP file you will create
in the following steps.

___r. Save and Close the assembly diagram file.

6. The HelloWorld application includes a Web interface to allow users to invoke the HelloWorld service
component from a Web browser. Before importing the client JSP file that includes the appropriate
client code to invoke the HelloWorld service, create a new Web module to hold this client interface. .
(Step 6 is required for 6.0.1 and beyond but is not required for version 6.0)

___a. If you are in Business Integration perspective, switch to the J2EE Perspective by selecting
Window - Open Perspective -> Other and check the box next to Show all. Select J2EE and
click OK

___b. Expand Enterprise Applications.
__c. Right click on HelloworldApp and select New - Other...

___d. From the Select Wizard dialog, expand Web and select Dynamic Web Project from the list.
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4= New B3

Select a wizard

Create a Dynamic Web project

Wizards;

G- Test -
== Weh

----- |#] Faces 15P File

----- L@ Fileer

----- 57 HTML{EHTML File J
----- [& Image File

----- % Javascript File
----- [¢ 15P File

EN iFa_ruela | ickanar
( v show al Wizardé) o

< Back I Mexk = I Eimish Cancel

___e. Click Next

___f. Click OK over the Confirm Enablement dialog

___g. Enter HelloWorldClient for the name of the Dynamic Web project.
___h. Click Finish .

Click Yes to confirm a switch to the Web Perspective.

NOTE: This will enable the Web Development capability within WebSphere Integration Developer for this
workspace.

7. For this exercise you will import the client JSP file that includes the appropriate client code to invoke
the HelloWorld service component created in the previous steps.

__a. Select File > Import from the menu.
___b. Select ‘File System’ and click Next.

___¢. From the File system import dialog click the Browse button and choose the following ‘From
directory ' : <LAB_FILES>\SCA\HelloWorld\import
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___d. Select the checkbox next to the index.jsp file.

___e. Click the Browse button to select HelloWorldClient/WebContent  as the ‘Into folder .

4= Import
File system o
Import resources From the local File syskem, | a"—|7
|
From direckary: I Z:LabFilesa02y3C A Helov arldiimport j Browse. .. |
""" L=+ impork O m HellovworldImpl . java

inde:x, jsp

Filker Iypes...l Select Al Deselect Al |
Inko Folder: IHEIIDWDrIdCIient,l'WebCu:untent Browse, . |
Options:

o Civerwrite existing resources withauk warning
" Create complete Folder struckure

¥ Create selected Folders only

Zancel |

< Back Mext =

___f. Click Finish .

8. Open the index.jsp file and inspect the client code that is used to invoke the HelloWorld service
component.

__a.If you are in Business Integration perspective, switch to the Web Perspective by selecting
Window -> Open Perspective - Other and check the box next to Show all. Select Web and

click OK.

___b. Expand Dynamic Web Projects -> HelloWorldClient - WebContent from the Project Explorer
view and double click on index.jsp .
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___C. Click on the Source tab after the JSP editor opens and examine the following code.

Locate the HelloWorldInterface

s
o

if (request.getParameter [("message™) '=s null) {
try |
ServiceManager serviceManager = new ServiceManager () :
HelloWorldInterface service = (Hellolorldlnterface)] servicelanager

locateService | "HellnMurldInte@tner"
Name of standalone reference
Ftring theMessage = request.getParameter [("message™)
Jystem.out.printlni"Sending wessage: " + theHessage],
String resp = service.sendMessage (theMeszage) ,<—an°ke serVice
System.out.printlni"Response: " + response):;
if (resp !'= null) {
out.println{"<p>" + resp + "</ p="):
}
} catch (Exception e) |
System.out.printlnie);

S
___d. Close the index.jsp file.
9. Add HelloWorldClient Web project as a J2EE dependency
_a In the Business Integration view's tree, expand HelloWorld and double-click on Dependencies
(Lﬂ-u st ) 10 open the Dependency Editor
e 4y
' *Dependencies: He / -
Libraries =
Configure the required libraries,
Advanced:
O ceploy with Module
| add... | | Remove |
Java
4@E (web, EJE. Eunnectur@
Predefhined Resources
Ordering
Unresolved Projects —
1| | 3
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b. In the Dependency Editor, expand J2EE and click the Add button to add HelloWorldClient as
J2EE dependent project

c. From the J2EE Project Selection panel, select HelloWorldClient listed and click OK

d. Ensure that the check box next to Deploy with Module is selected by selecting the
HelloworldClient module

JZ2EE [Web. EJB. Connector, etc)
Configure the dependent 1ZEE projects such as Web, EJB, and Connectar modules, The selected
projects will be deploved as part of the module,

& oWworldClient advanced:

on Build Path

Cl¥] Deploy with Module

| add. .. | | Remove |

e. Save and Close the Dependency Editor
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Part 3: Testing HelloWorld from the Web interface

1. Start the server.

___a. If using a remote testing environment, follow the directions provided in Task: Adding Remote
Server to WebSphere Integration Developer Test Envi _ronment  at the end of this document
to add a server to the WebSphere Integration Developer test environment and start it. This is
especially true for z/OS, AlX, Solaris remote test environment, where the WebSphere Integration
Developer will be remote to the test environment.

If using a local testing environment, right click on WebSphere Process Server V6.0 from the
Server view and select Start from the context menu.

___b. Wait until the sever status is indicated as Started .
2. Add the HelloWorld project to the configured projects on the server.

___a. From the Servers view right click on WebSphere Process Server V6.0 and select Add and
remove projects... from the context menu.

___b. Select HelloworldApp from the available projects list and click Add .
___c. Click Finish .
3. Test the HelloWorld service component.

___a. Open a Web browser and enter the following URL.
htt p: / / <HOSTNAME>: 9080/ Hel | oWor I dd i ent /i ndex. j sp

NOTE: To open the embedded browser within WebSphere Integration Developer V6.0.2, select Window
- Customize Perspective from the menu. In the Customize Perspective dialog click on the Commands
tab and scroll to the bottom of the available command groups list until you find Web Browser. Check the

box next to Web Browser and click OK. Click the Web browser icon ('@) now in your toolbar to open the
embedded Web browser.

___b. Verify that you see the following page displayed in the browser.

|
|http:,f,l'lu:ucalhu:ust:QEISI:I,I'HeIIan:urIu:ICIient,l’index.jsp j =3 | Hr - = q)(h' | ﬁ
=

Hello World Application

Enter a message: |

Submit |

___c. Enter Hello World for your message and click Submit .
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___d. Verify that you see the following output.

O
Ihttp:,l',l'localhost:9DEDIHeIIDWDrIdCIientIindex.jsp?message=HeIIo+WorId j = | e - O = @h | ﬁ
» »
Hello World Application
Enter a message: |
Submit |

f— . .
C@owmg message was subrmitted: HEH@
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Part 4: Testing using the Integration test client

1. The integration test client can be invoked on a service component from the assembly diagram.
Open the assembly diagram and launch a component test on the HelloWorld Service component.

NOTE: If you are in J2EE or Web perspective, switch to the Business Integration Perspective by selecting
Window -> Open Perspective -> Other and check the box next to Show all. Select Business
Integration and click OK.

___a. Expand Helloworld and double click on Assembly Diagram from the Business Integration view.

Right click on the Helloworld world component from the HelloWorld Assembly Diagram and
select Test Component from the context menu.

Verify that the Test Editor opens in your work area.

*Helloworld Tesk X B

Events B EE

% Select the compaonent, interface, and operation you would like ko invoke, Click Continue ko run,

Events * General Properties

TS 1ol = Detailed Properties

Confiquration: IDeFauIt Module Test

Maodule: IHEII:::'-.-'-.-'Drlu:I

Component; IHEIID'-.-'-.-'DrId

Inkerface: IHEIIDWDrIdInterFace

Lef L L e 1

Qperation: IsendMessage

Initial request parameters

Mame | Tvpe I Yalue I

Message string

Events | Configurations |

2. For this test invoke the HelloWorld service component with the message “Hello World 2”.

Locate the table that lists the initial request parameters under the “Detailed Properties” section.
Enter Hello World 2 for the message parameter value (Under Initial request parameters).

Click the Continue button underneath the parameters table to invoke the test.
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Expand WebSphere Process Server and select WebSphere Process Server v6.0 from the
Deployment Location dialog.
+= Deployment Location

Select Deployment Location

This server instance is currently running. " l__ [

Ceployment location:

5---% WebSphere Process Servers Mew Server, ., |

i 2pnere
B Edlipse 1.4 1M

------ Fﬁi WEI Monitar Servers

Maode: IRun j

[ Use this as the defaul: and do not ask again

S

®eccccoe

Click Finish .
3. Once the test is completed, verify that the invocation response is: “The following message was
submitted: Hello World 2”.
Events b General Properties
EI---I‘,}/‘; Inwoke (HelloWorld: sendMessage) + Detailed Properties
E|‘F‘> Started
Module: Helloworld
Component: Hellawarld
Interface:  HelloworldInkerface
Dperation:  sendiMessage
Beturn paramesters:
Narme [ Type |‘£§.|H?------- .....
:}t’at‘us b skring The Following message was submitted: Hello World 2 ° ® ..'.o
4. Close the test editor without saving the data file associated with the test run. Close the HelloWorld
assembly diagram.
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Part 5: Restore server configuration
1. Remove the HelloWorld project from the configured projects on the server.

___a. Right click on WebSphere Process Server v6.0 sever from the Server view and select Add and
remove projects... from the context menu.

___b. Select HelloworldApp from the configured projects list and click Remove.
___c. Click Finish .
2. Stop the server.

___a. Right click on WebSphere Process Server v6.0 server from the Servers view and select Stop
from the context menu.
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What you did in this exercise

In Part 1 of this exercise you set up the development environment. Next, in Part 2 you assembled the
HelloWorld SCA module consisting of a single Java typed service component called HelloWorld that was
associated with a simple WSDL interface. The SCA module also included a stand-alone reference that
was used by a client JSP to invoke the HelloWorld service component. During the testing phase of this
exercise you tested the HelloWorld application first from the Web interface, and then also with the end-to-
end test client feature provided with WebSphere Integration Developer V6.0.2.
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Solution Instructions
1. Start WebSphere Integration Developer V6.0.2 with a new workspace
___a. Follow the instructions outlined in Part 1 of this exercise

2. Import the project interchange file HelloWorld_Pl.zip from
<LAB_FILES>\SCA\HelloWorld\Solution  directory.

__a. Select File = Import from the menu
___b. Select Project Interchange in the Import dialog and click Next

r Import

Select

Import a project and its dependent projects from a Zip file. ™,

Select an import source:

®, Probe i
g‘.i:i'_EF‘rl:uﬁIing file

,% Project Interchange

& RAR file

'i'_—flﬁecuritv Certificate

B2 Server Cnnfiniration

| Mext = | Cancel

___c. For the “From zip file ’, click on the Browse button and select the Helloworld_Pl.zip in the
<LAB_FILES>\SCA\HelloWorld\Solution  directory.

___d. Enter <LAB_FILES>\<LAB_NAME>\workspace for the Project location root and click Next
___e. Select the check boxes next to HelloWorld and HelloWorldClient
___f. Click Finish .

3. Continue with Part 3 of this exercise.
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Task: Adding remote server to WebSphere Integration Developer test
environment

This task describes how to add a remote server to the WebSphere Integration Developer Test
environment. The sample will use a z/OS machine.

1. Create a new remote server.
___a. Right click on the background of the Servers view to access the pop-up menu.

___b. Select New > Server.

i ]
Properties ‘ Problems Mnmh| o o A =g

Server | Host name | Status | State

ﬁ\*ﬂehﬂphere ESE Server v6.0 localhost E@ Stopped Synchronized
WebSpherE Process Server ve.0 localhost E& Stopped Synchronized

New ¥ ﬁ}Server I

___c. Specify hostname to the remote server, <HOSTNAME>.
___d. Ensure that ‘WebSphere Process v6.0 Server ’is highlighted in the server type list.

X

Define a New Server
Choose the type of server to create.

Specify the host where you want to publish

L

Host name: I mvexxy. rtp.raleigh.ibm, com|

Select the server type:
. L. webSphere ESB Server v6.0

il WebSphere Express v5.0 Server

ﬁ WebSphere Express w5, 1 Server

- WebSphere Process wa.0 Server
LM \ehSnhers wh Server Attach

L]

Led Lo

View By: |Vendor

Description: WebSphere Process v6.0 Server

___e. Click Next.

__f. On the WebSphere Server Settings page, select the radio button for RMI and change the ORB
bootstrap port to the correct setting (<BOOTSTRAP_PORT>).

2007 April, 04 IBM WebSphere 6.0.2 — Lab Exercise Page 23 of 26

WPSWIDv602_SCAlntroLab.doc



© Copyright IBM Corporation 2007. All rights reserved

4= New Server

Websphere Server Settings
Input settings for the new WebSphere senra]:

WebSphere profile mame:

SOAR conmeckar park:

I | Run server with resaurces within the WOr kSR ATE:
]

 authentication s

__g. Click Finish .

__h. The new server should be seen in the Server view.
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-,

a

WebSphere Process v6.0 Server @ mvswoocrtp.ral...

mvsxxx.rip.raleigh.ibm.com

Synchronized

Properties | Problems Ccnsnle| 15 O L =0
Server | Host name | Status | State

EWEbSphEFE ESBE Server va.0 localhost E‘@ Stopped Synchronized
'v'u'ebSphere Process Server va.0 localhost E‘g Stopped Synchronized

2. Start the remote server if it is not already started. WebSphere Integration Developer does not
support starting remote servers from the Server View.

___a. From a command prompt, telnet to the remote system if needed:

‘telnet <HOSTNAME> <TELNET_PORT>"

userid : <USERID>

pw: <PASSWORD>

___b. Navigate to the bin directory for the profile being used:

cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin

___c. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

___d. Wait for status message indicating server has started:

ADMU3200I1 : Server launched. Waiting for initialization status.
ADMU3000I : Server cl1sr0l1 open for e-business; process id is 0000012000000002
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